
Getting Started 
with Dana

AlphaSmart, Inc.

www.alphasmart.com



ii

AlphaSmart Sales and Technical Support
For AlphaSmart Sales and Technical Support contact information 
please see page 83.

Nothing in this manual may be reproduced in any manner, either 
wholly or in part, for any purpose whatsoever without written 
permission from AlphaSmart, Inc.

Be sure to make backup copies of all important data on other media to protect
against data loss. Important: Please read the End User Software License Agreement
with this product before using the accompanying software program(s). Using any
part of the software indicates that you accept the terms of the End User Software
License Agreement.

AlphaSmart, Dana by AlphaSmart, AlphaSmart 3000, and Renaissance Learning are
trademarks of Renaissance Learning, Inc., and its subsidiaries, registered, common
law, or pending registration in the United States and other countries. Microsoft
Word and Excel are registered trademarks of the Microsoft Corporation. Macintosh
is a registered trademark of Apple Computer, Inc. Palm OS is a registered trademark,
and Palm, the Palm and the Palm Powered logos are trademarks of Palm, Inc. or its
subsidiaries. Third-party products and brand names may be trademarks or registered
trademarks of their respective owners.

Copyright 2007, Renaissance Learning, Inc. All rights reserved.



Contents
Chapter 1 - A Dana Tour
Utilizing Dana’s wide screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3
Preparing to use Dana  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3

Charging Dana . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
Dana first time set up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4

WritePad basics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5
Using the screen’s backlight  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
Adjusting the LCD contrast  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
Upgrading from a Palm OS handheld . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
Installing desktop software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
Connecting Dana to a computer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
Synchronizing data using HotSync . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
Chapter 2 - AlphaWord
AlphaWord Basics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13

Creating an AlphaWord document . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14
Using Spell Check . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
Using Thesaurus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16
Printing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Connecting to your Computer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19
Send versus HotSync. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
HotSync a new AlphaWord document to your computer . . . . . . . . . . .  19
Sending text to your computer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20
HotSync a desktop document to AlphaWord . . . . . . . . . . . . . . . . . . . .  21

AlphaWord In-depth  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22
AlphaWord controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22
Deleting a document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25
Installing additional fonts on Dana. . . . . . . . . . . . . . . . . . . . . . . . . . . .  25
Setting a file password  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Chapter 3 - Onboard Applications
Launching Applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .29
Using Address Book . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30

Creating an Address Book entry . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Viewing and changing an Address Book entry  . . . . . . . . . . . . . . . . . . .  31
Deleting an Address Book entry . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Using Date Book  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .32
Creating an event . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Creating an untimed event  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
iii



Creating a repeating or continuous event  . . . . . . . . . . . . . . . . . . . . . . .  35
Rescheduling an event . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36
Changing the calendar view  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36
Deleting an event. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Using To Do List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Creating a To Do List item . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39
Changing a To Do List item  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39
Marking a To Do List item complete  . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Deleting a To Do List item  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Using Memo Pad  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Creating a memo. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Reviewing and changing a memo  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43
Deleting a memo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Printing from Date Book, Address Book, To Do List or Memo Pad . . . . . . 44
Preferences and other settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Changing the Applications Launcher display. . . . . . . . . . . . . . . . . . . . .  45
Setting Date and Time preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Setting General preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48
Changing Formats preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Customizing keyboard settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Chapter 4 - Dana In-Depth
Beaming information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Beaming data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53
Beaming applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54
Receiving beamed information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55
Beaming your business card  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55

Installing applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Resetting Dana . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Performing a soft reset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60
Performing a hard reset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  61

Installing alkaline batteries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Using expansion cards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Inserting an expansion card. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63
Removing an expansion card  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64

Frequently Asked Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Online Help and additional information . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Appendix A - Keyboard Navigation . . . . . . . . . . . . . . . . . . .  71
Appendix B - International and Special Characters . . . . . . . .  75
Appendix C - Warranty and Guarantee  . . . . . . . . . . . . . . . .  81
Appendix D - Contact Information and Return Procedures . . .  83
iv



CHAPTER 1 A Dana Tour
Dana™ by AlphaSmart® is the versatile laptop alternative for students, 
researchers and professionals on the go. It combines the convenience and 
affordability of a Palm-Powered™ device with the ergonomics of a lightweight 
laptop. Dana is easy to use, rugged and has exceptional battery life to keep you 
working while away from your computer. Use your new electronic notebook to 
do the following: 

• Compose documents in AlphaWord, a full-featured word processor.

• Enter your schedule in Date Book, and set alarms to remind you of 
important meetings.

• Keep contact names, addresses, and phone numbers in Address Book.

• Prioritize and assign your tasks a due date in To Do List.

• Synchronize your data with Palm™ Desktop software on a Windows or 
Macintosh computer so you always have a copy.

• Insert Secure Digital (SD) or MultiMedia Card (MMC) expansion cards to 
add additional software applications or hardware, or to back up data.

• Beam information to another Dana or Palm OS ® handheld that has an 
IrDA (infrared) port; beam printable files to an IrDA-equipped printer.

This guide Getting Started with Dana, provides information about performing 
basic tasks on Dana and with Palm Desktop software. The guide generally 
gives the keyboard commands for a task, but you can also tap on Dana’s screen 
with your stylus to perform most tasks. For information about performing 
more advanced tasks, refer to the Dana User’s Guide. To open that guide, 
double-click DanaUsersGuide.pdf located in the DanaInfo folder inside the 
Palm folder on your computer.

Documentation Note: In this document keyboard keys will be 
shown in bold. Also any “two-key” key commands (i.e. function-
calc) are executed by pressing the indicated keys simultaneously.
Getting Started with Dana 1





Utilizing Dana’s wide screen
Dana utilizes all the power and efficiency of the Palm operating system, 
and expands its capabilities with a larger screen, the inclusion of the 
AlphaWord word-processing application and many other features.

AlphaWord functions at the full Dana screen resolution of 160x560 
pixels, and most of the standard Palm applications like Address Book, 
To Do List, Memo Pad and Date Book have also been updated to take 
advantage of the larger screen. 

However, other Palm programs might not have been revised to run on 
Dana's larger screen. The functionality of the Palm program won't be 
restricted in any way, but the program will run in narrow mode 
(centered in the middle of the Dana screen).

Preparing to use Dana
Before you begin using Dana and the Palm desktop software, you must 
complete a few easy installation steps.
Getting Started with Dana 3
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Important: The version of Palm Desktop Software 
that comes with Dana must be installed before 
connecting Dana to a computer.

Charging Dana 
Dana comes with a rechargeable battery that recharges whenever it 
is connected to its AC Adapter or to the computer via a USB cable 
(charging will only occur while the computer is on). You can also 
use standard AA alkaline batteries (not included).

You will need to connect Dana to the AC adapter for four hours or 
the computer for eight hours to get a full charge. Use the AC 
adapter that comes with Dana, or one that meets the following 
specification: Input: AC 120v 60Hz 9W Output: DC 7.5V 500 
mA. A fully charged Dana should run for over 25 hours. 

Using the AC adapter
1. Connect the AC adapter to the Dana AC port.

2. Plug the AC adapter into any AC current outlet.

Dana first time set up
1. Press the on/off key to turn on Dana.

2. Follow the on screen instructions to calibrate the Dana screen 
and set the current date and time.

Note: If Dana does not turn on, see “Frequently 
Asked Questions” on page 64 for troubleshooting 
suggestions.

Important: For users outside the United States, 
choose the same language for Dana and Palm 
Desktop software. Choosing a language that does 
not match the Palm Desktop software is not 
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recommended or supported, and may result in data loss. 
If you need to reselect a language on Dana, you must 
perform a hard reset. See “Resetting Dana” on page 60 
for details.

WritePad basics
The WritePad provides a quick means to access applications, their 
menus and some special functions. The illustration below gives a 
functional overview of WritePad features.

Note: WritePad is only displayed for applications running 
in narrow mode (including those on a rotated screen).

Entering data
The most obvious way of entering data on Dana is using its full-size 
keyboard. For applications running in narrow mode, you can also 
enter data using the onscreen keyboard or Graffiti® 2 writing on the 
WritePad. To find out more information, launch the Graffiti 
application. You can also accept beamed data from another Dana or 
Palm OS handheld that has an infrared port. See “Beaming 
information” on page 53 for details.

Adjusting the WritePad
You can select the side of the screen where the WritePad displays by 
clicking on the right or left arrow at the bottom of the WritePad screen.

Home – displays 
Applications 
Launcher

 

Menus – displays 
command menus for 
active application

Calculator – 
displays onscreen 
calculator

Find – displays Find 
dialog 
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You can also minimize the WritePad by clicking on the single 
arrow at the top of the WritePad screen.

Using the screen’s backlight
Warning: Using the backlight feature significantly 
reduces battery life.

1. Press the on/off key to turn Dana on.

2. Press the on/off key again and hold for about two seconds. 
Release the key when the backlight turns on.

3. Press the on/off key and hold for about two seconds to turn off 
the backlight.

Click on the left arrow to move the WritePad to the left of the screen

 Click on the down arrow to minimize the WritePad

 Click up arrow to restore the WritePad to its normal size
Dana Tour



Note: The backlight also turns off automatically after a 
period of inactivity defined by the Auto-off setting. See 
“Setting General preferences” on page 48 for details.

Adjusting the LCD contrast 
1. Press function-contrast (hold down the function and contrast keys 

at the same time) to bring up the Adjust Contrast dialog.

2. Adjust the contrast setting by pressing function-PgUp or function-
PgDn on your keyboard.

3.  Tap Done.

Upgrading from a Palm OS 
handheld 
If you already own a Palm OS handheld, you must install the version of 
Palm Desktop software that comes with Dana before connecting Dana 
to your computer via a USB cable. Also, perform a HotSync® 
operation using your old handheld and cradle/cable before you install 
the new Palm Desktop software. This ensures that all data on your 
handheld is on your desktop computer, and is available for easy 
transfer to Dana.

If you want to continue using your old Palm OS handheld as well as 
Dana, you will need to choose a new user name for Dana during Palm 
Desktop software install on a PC or during the first HotSync on a 
Macintosh. You will also need to export any data from Palm Desktop 
Getting Started with Dana 7
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software that you want to transfer to Dana. Later you can import 
this data into your new Dana user name.

Exporting/Importing Data from Palm Desktop 
Software
1. Launch the Palm Desktop Software you use with your old 

handheld.

2. Go to an application you want to export data from (i.e. Date 
Book).

3. Select Export under the File menu.

4. Type in a file name and click the Export button.

5. Repeat steps 2-4 for the other applications (i.e. Address Book, 
To Do List, and Memo Pad).

6. Once you have completed “Installing desktop software” on 
page 8, launch the new version of Palm Desktop software. 
Select Import under the File menu to import the files that you 
exported in step 4.

Each device should have a unique 
name
To prevent unexpected results during HotSync operations and 
possible data loss, Danas that HotSync to the same computer 
should not have the same user name. If you plan to continue using 
your old handheld as well as Dana, make sure you create a new 
user name for Dana. 

Installing desktop software
Palm Desktop software includes most of the same applications 
found on Dana: Date Book, Address Book, To Do List and Memo 
Dana Tour



Pad. You can use the HotSync Manager to backup and exchange data 
between Dana and your computer.

If you are upgrading, you may want to create a copy of your old Palm 
Desktop software folder and its contents before installing new Palm 
Desktop software. This is optional. If you do this, rename the copied 
folder (for example, Palm Backup), and store it outside the Palm 
Desktop software folder.

Important: The version of Palm Desktop Software that 
comes with Dana must be installed before connecting 
Dana to a computer.

Note: If you are using Microsoft Outlook or other 
organizer software instead of Palm Desktop software, 
you will need to complete the Palm Desktop software 
installation to ensure that HotSync Manager, conduit 
software, and other features of Palm Desktop software 
are installed on your computer.

Installing Palm Desktop software on a PC

Note: If you are upgrading and your old Palm Desktop 
software is version 1.0 or 2.0, copy your old Palm 
Desktop software folder and its contents into a folder of a 
different name (for example, Palm Backup), then 
uninstall your old Palm Desktop software.

Important: Palm Desktop Software for the PC requires 
Windows 98 or newer.

1. Insert the Palm Desktop for Dana Software CD-ROM into the CD-
ROM drive

2. When the window showing the CD's contents opens, double-click 
on setup.exe.

Note: If a window showing the CD's contents does not 
appear, click the Windows Start button, choose Run, 
Getting Started with Dana 9
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enter D:\setup.exe, and then click OK. If necessary, 
replace D: with the drive letter assigned to your CD-
ROM drive.

3. When the Palm Desktop software Installer Menu screen 
appears, click the Install button to begin the installation 
procedure.

4. Follow the onscreen instructions to complete the installation.

Important: If you already own a Palm OS handheld 
and want to continue using it, you should create a 
new user name to use with Dana.

During installation, you may be asked to connect Dana to the 
computer using the USB cable.

Installing Palm Desktop software on a 
Macintosh

Note: If you are upgrading and your old Palm 
Desktop software is version 1.0 or 2.0, copy your old 
Palm Desktop software folder and its contents into a 
folder of a different name (for example, Palm 
Backup), then uninstall your old Palm Desktop 
software.

Important: Palm Desktop Software for the 
Macintosh requires OS 9 or higher.

1. Insert the Palm Desktop for Dana Software CD-ROM into the 
CD-ROM drive.

2. Double-click the Palm Desktop CD icon.

3. Double-click the Palm Desktop Installer icon.

4. Follow the onscreen instructions to complete the installation.
Dana Tour



Connecting Dana to a computer
Dana comes with a USB cable for connecting to a PC or Macintosh for 
the speedy exchange and update of applications and files.

1. Connect one end of the USB cable to the Dana computer port.

2. Connect the other end of the cable to a USB port on the computer.

3. The computer will automatically recognize the connection

Synchronizing data using HotSync 
The HotSync® process automatically synchronizes—that is, exchanges 
and updates—data between Dana and the Palm Desktop software on 
your computer. Changes you make on Dana or Palm Desktop software 
appear in both places after a HotSync operation.

1. Connect Dana to a computer with the USB cable.

Important: The version of Palm Desktop Software that 
comes with Dana must be installed before a Hotsync.

2. Press function-sync (hold down the function and sync keys 
simultaneously on Dana).

3. When the Users dialog box appears, on a PC select the user name 
you entered when you installed the Palm Desktop software. On a 
Getting Started with Dana 11
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Macintosh enter a new user name, or choose an existing name if 
you are upgrading and no longer wish to use your old 
handheld. See “Upgrading from a Palm OS handheld” on 
page 7 for more information.

4. Wait for a message on Dana indicating that the process is complete  
before disconnecting Dana from the USB cable.

Note: Your user name is the connection between 
Dana and your computer. If sharing Palm Desktop 
software with another user, change users by selecting 
a name from the User list in the top right corner of 
Palm Desktop. 
Dana Tour



CHAPTER 2 AlphaWord
AlphaWord is a full-featured word processor that lets you create, 
format (including setting fonts, justification, line spacing, indents), and 
edit documents. These documents can then be printed or transferred to 
a computer via a USB cable or a wireless connection. This chapter will 
cover the fundamentals of AlphaWord.

AlphaWord Basics

Files 1-8
In AlphaWord you are always in one of eight workspaces that you can 
instantly access using their corresponding file keys (F1-F8). You can 
use the workspaces for your work in progress. When you press one of 
the file keys in AlphaWord, the associated file immediately opens. This 
eliminates having to scroll through a long list of files to find the one 
you want to open. If there is no file associated with the file key you 
pressed, then a new file is created.

Tip: To replace a file associated with a workspace with a 
different file, press the menu key, then select File New for 
a new file or File Open for an existing file.
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Creating an AlphaWord document
1. Press the memo key or tap the AlphaWord icon in the 

Applications Launcher.

2. If there are no existing files AlphaWord will automatically open 
a new file, otherwise select New under the File menu. 

Note: The first time you start AlphaWord it will 
automatically open a new file; otherwise, it will go to 
the file you were in last. Press one of the F1-F8 keys, 
to go to the file associated with that workspace.

3. Enter the text you want to appear in the document.

Note: To use Tab in documents see “Tab key option” 
on page 49.

4. Use the buttons on the toolbar to add formatting including 
setting fonts, justification, line spacing, indents, etc.

5. To name your file, choose Save As under the File menu.

Note: Once you’ve named your file, AlphaWord 
automatically saves it when you leave AlphaWord or 
open another file, so you don’t need to worry about 
losing your data. You can also force AlphaWord to 
save at any time by choosing File Save.
AlphaWord



6. Enter a name for the new document, and then press function-ok.

Using Spell Check
1. Create a document or open an existing document.

2. Press the menu key. Under the Edit menu tap Check Spelling.

Note: The larger data file for the Spell Checker that 
contains more words(AWSpellLarge.pdb) should be 
automatically installed the first time you HotSync. To 
check if it is installed: press the apps key, then press the 
menu key and select Info under the App menu. If 
SpellData is in the list, then the larger data file is 
installed. If it isn’t, you can HotSync it to Dana now. 
AWSpellLarge.pdb is located in the DanaExtras folder 
under the Palm folder on your computer. For more 
information on HotSyncing the file to Dana, see 
“Installing applications” on page 55.

3. Tap the selection you want to spell check.

Tip: To bypass this menu, select the text you want to spell 
check before choosing Check Spelling from the menu.
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4. Tap the appropriate button.

Using Thesaurus
1. Create a document or open an existing document.

2. Select the word for which you want to find a synonym.

3. Press the menu key. Under the Edit menu tap Thesaurus.

Note: The data file for the Thesaurus 
(ThesData.PDB) should be automatically installed 
the first time you HotSync. If it isn’t, you can 
HotSync it to Dana now. It can be found in the 
DanaExtras folder under the Palm folder on your 
computer. For more information, see “Installing 
applications” on page 55.

Underline indicates 
misspelled word.

Tap Ignore to skip the 
word and continue 
checking the document. Tap 
All to ignore all instances of 
the word in the document.

Select the correct 
word in the list, then 
tap Change to 
replace the mis-
spelled word. Tap All 
to replace all 
instances of the word 
in the document.

Tap Add to add the  word to 
a supplemental dictionary.

Tap Edit to type in 
a word.

Tap Opt.. to change 
Spell Checker 
options.
AlphaWord



4. Tap the appropriate button.

Printing Setup
1. Press the apps key repeatedly till you see ALL in the top right corner 

of the Applications Launcher.

2. Tap the Print icon.

3. Tap the Setup button.

4. Choose your printer from the Printer pick list.

5. Tap the Set As Default button.

Choose the type 
of word you 
want

Select a word in the 
synonym list, and then tap 
Apply for it to replace the 
original word

Select a word in the synonym list, 
and then tap Lookup to find syn-
onyms for it

You must tap here 
after selecting your 
printer to save your 
settings
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6. Tap the Edit button.

7. Choose IrDA or USB from the Port: pick list. Tap OK.

Important: You must tap OK on this screen for Dana 
to print.

8. Tap OK.

Printing 
Dana comes with PrintBoy Anywhere which lets you print from 
AlphaWord as well as other applications. For more information on 
printing from other applications see “Printing from Date Book, 
Address Book, To Do List or Memo Pad” on page 44.

1. Open the document you want to print in AlphaWord.

Tip: You can also print documents directly from the 
PrintBoy application. For more information see the 
Dana User’s Guide.

2. If you are printing via USB, connect one end of the USB cable to 
the Dana printer port and connect the other end of the cable to 
the printer. If you are printing via infrared (IrDA), point Dana’s 
IrDA port at the Printer’s IrDA port. 

3. Press the menu key, and then under the File menu tap Print.

Tap pick list to 
change port

Tap to change the 
page size Tap to change the left 

margin
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4. Tap a checkbox if needed, and then tap the Print button.

Connecting to your Computer

Send versus HotSync
AlphaWord gives you two options for transferring information to a 
desktop computer. HotSync will transfer your document and preserve 
its formatting (fonts, justification, line spacing, indents, etc.) The 
document can then be opened in any application that can read RTF 
files (Rich Text Format) including Microsoft Word, WordPad, 
AppleWorks, etc. Send will send plain text (no formatting) to any 
application that accepts text. HotSync works with a USB connection, 
while Send works with either a USB or wireless (IrDA) connection.

HotSync a new AlphaWord document to 
your computer
1. Create and save a document.

2. Press the apps key.

3. Connect Dana to your computer via a USB cable, then press 
function-sync.

Tap to enable printing 
of header with file 
name and date

Tap to disable printing of 
page numbers
Getting Started with Dana 19



20
Important: The version of Palm Desktop Software 
that comes with Dana must be installed before a 
Hotsync.

4. HotSync will put the new document in your My Documents 
folder (PC) or the AlphaWord folder inside your Palm user 
folder inside the Palm desktop folder under Documents 
(Macintosh). 

 Note: If you specified a different folder for 
AlphaWord documents in AlphaWord Sync 
preferences, Hotsync will put your documents there. 

5. To open the document, launch AlphaWord Sync on your 
computer, select the document and double-click on it.

Warning: By default if you have edited a document 
on your desktop and Dana, HotSync treats the 
document on Dana as the latest version of the 
document, and backs up the version on your desktop. 
For more information on synchronization see the 
Dana User’s Guide.

Sending text to your computer
To send text without formatting (such as fonts, justification, 
spacing, etc.) to an application on your PC or Macintosh, follow 
these steps: 

1. On a PC or Macintosh open any application that accepts text, 
and open a new file.

Note: If you are transferring text via a wireless 
connection (IrDA), launch AlphaBeam on your 
computer. For more information on installing 
AlphaBeam see the Dana User’s Guide.

2. On Dana open the document you want to transfer.
AlphaWord



3. Connect Dana to your computer via a USB cable or point Dana’s 
infrared port at your computer’s IrDA port, then press send.

4. The text will appear in the application on the Macintosh or PC. 

Note: For wireless (IrDA) transfer there is file size limit of 
50K on a PC and 32K on a Macintosh.

HotSync a desktop document to 
AlphaWord
On a PC you can HotSync any Microsoft Word or RTF (Rich Text 
Format) file. On a Macintosh you can HotSync any RTF file. Text files 
on a Macintosh or a PC must be converted to the correct format before 
they can be transferred to AlphaWord.

Tip: To convert a file to RTF (Rich Text Format) use the File Save As 
command (found in most word processors). Open the file in your word 
processor and choose File Save As.

1. Launch AlphaWord Sync on your computer.

2. To select which document(s) will be sent to AlphaWord either:

• Drag-and-drop the document onto the AlphaWord Sync window.

• In AlphaWord Sync use the Add button to select a document.

3. Press the apps key on Dana.

4. Connect Dana to your computer via a USB cable, then press 
function-sync.

5. When HotSync is done, the document will be in the AlphaWord file 
list. Select Open under the File menu to view the document in 
AlphaWord.
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AlphaWord In-depth

AlphaWord controls

• Paragraph formatting button  Opens the paragraph 
formatting dialog box (covers justification, indenting, line 
spacing, etc.) 

• Justification button  Indicates whether the memo is left, 
right, full justified, or centered. Tap to change the justification. 

• Bold button  Turns on bold. Highlighted if enabled.

• Underline button  Turns on underline. Highlighted if 
enabled.

• Italics button  Turns on italics. Highlighted if enabled. 

• Fonts button  Indicates what Font type and characteristics 
have been selected. Tap to change fonts.

 
 
 
 

 
 
 

Tap on the arrow to hide or 
show the toolbar

  

Tap the toolbar to access 
various formatting functions

 
 

Tap or drag Scrollbar to move through the document

Shows the current 
workspace

Document name
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• Arrow  Tap the arrow in the right hand corner to hide the 
toolbar. Tap on it again to get it back.

• Scrollbar Moves the cursor up and down in the document. Slowly 
scroll by putting your stylus on the up or down arrow, or quickly 
move through the document by dragging the bar on the scrollbar.

Cursor movement
In AlphaWord (and other Dana applications), you can move the cursor 
using the following keystrokes: 

Text selection 
You can select text by using these keyboard keys:

TABLE 1. Cursor Movement Keyboard Commands

Ctrl-Left Arrow move cursor to the previous word 

Ctrl-Right Arrow move cursor to the next word 

Cmd-Left Arrow move cursor to the beginning of the line 

Cmd-Right Arrow move cursor to the end of the line 

Cmd-T move cursor to the top of the document

Cmd-E move cursor to the bottom of the document

TABLE 2. Text Selection Keyboard Commands

Shift-Left Arrow select one character to the left 

Shift-Right Arrow select one character to the right 

Ctrl-Shift-Left Arrow select previous word 

Ctrl-Shift-Right Arrow select next word 
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Cut, copy, paste and select
These commands are equivalent to those used on PCs or 
Macintosh: 

Editing an existing AlphaWord 
document
1. If the file you want to open is associated with a workspace, 

then just press the appropriate file key (F1-F8) to open the file.

2. If the file you want to open is not associated with a workspace, 
press the menu key. Select Open under the File menu.

Shift-Up Arrow select the previous line 

Shift-Down Arrow select the next line 

TABLE 3. Text Manipulation Keyboard Commands

Ctrl-C or cmd-C copy selected text into the clipboard 

Ctrl-V or cmd-V paste the text from the clipboard 

Ctrl-X or cmd-X cut selected text into the clipboard 

Ctrl-A or cmd-A select all text in the current text field or document

Ctrl-backspace deletes previous word

Ctrl-del deletes next word

TABLE 2. Text Selection Keyboard Commands
AlphaWord



3. Use the up or down arrow key to highlight the document you want 
to view or edit, then press the enter key.

Deleting a document
1. Open the file you want to delete.

2. Press the menu key. Select Delete Doc under the File menu.

3. Tap OK.

Installing additional fonts on Dana
AlphaWord allows you to add additional fonts to use in your 
documents to improve their appearance and readability.

1. Launch FineType Converter on your PC. FineType Converter is 
automatically installed on your desktop when you install Palm 
Desktop Software.

Note for Macintosh Users: FineType Converter is only 
available for Windows. If you have access to a PC, we 
suggest installing fonts from there or if you have a 

 Tap a document to edit its contents

 

 
Indicates which 
file key the file 
is mapped to
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handheld device you’ve already installed them on 
from a PC, you can beam them to your Dana.

2. Click on the font name you want to install, then click on the 
Install button. 

Tip: To select multiple fonts, hold down the Ctrl key 
while clicking the fonts.

3. HotSync to install the selected fonts on Dana.

Note: Fonts take up memory on Dana, so only load 
fonts that you will really use.

Using Fonts
1. Open the document whose fonts you want to change.

Click or Ctrl-click to 
select fonts
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2. Tap the fonts button on the toolbar or choose Font from the Format 
menu.

3. Choose a font from the Font: pick list.

4. Tap the OK button.

Note: A font may appear in the Font: list, but not display 
in AlphaWord or the Sample box. A font will only display 
if the actual font has been installed on Dana. In the Font: 
list installed fonts are shown in bold. If you choose a font 
that is not installed on Dana, but is installed on your 
computer, when you send the document back to your 
computer the font will display.

Setting a file password
1. Open the document that you want to password protect.

2. Press the menu key. Select Set Password under the File menu.

3. Tap the Enable Password checkbox.

4. Type in a password that is between 1 and 30 alphanumeric 
characters. Tap OK. Tap OK.

Tap the Font pick list to 
change fonts - Installed 
fonts are shown in bold

 

 

Check a box to change 
font attributes

Tap arrows to change font 
size or type in a number 
between 4 and 127

Shows what the 
selected font will look 
like

Tap checkbox to set a 
password
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Tip: Passwords are case sensitive, so make sure caps 
lock is not on when entering your password.

5. Next time you open the document you will be prompted for a 
password.

Tip: If you forget the password for a file, you can 
open the file using the master password. To obtain 
the master password contact technical support using 
the contact information listed on page 83.

Turning off a file password
1. Open the password protected document.

2. Press the menu key. Select Set Password under the File menu.

3. Uncheck the Enable Password checkbox.

4. Tap OK.
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CHAPTER 3 Onboard Applications
Dana includes many of the standard Palm applications, as well as 
some of its own. This chapter will review the fundamentals of those 
applications. See the Dana User’s Guide for more in-depth information 
on all program features.

Launching Applications
When you turn on Dana, the Applications Launcher displays a list of all 
the applications on Dana. You can always return home to the Applications 
Launcher by simply pressing the apps key. You can also display only 
selected applications by arranging applications into categories. Press the 
apps key repeatedly to cycle through all the categories.

A rectangle around the Address book icon shows that it is selected. 
Once selected, any application can be launched by pressing the enter 
key. You can also launch an application by tapping it with the stylus.

Applications Launcher with 
Address application selected

 
Press the apps key or 
tap the category pick list 
to switch to a different 
category
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Selecting applications: 
• Use the arrow keys to move between applications, or the Tab 

key to cycle through all the applications from left to right.

• You can also select an application by typing the first letter of an 
application’s name, which will jump the selection box to the 
application. If more than one application starts with the same 
letter, then type the first few letters of the one you want to 
select.

Using Address Book
Address Book enables you to store names, addresses, phone 
numbers, and other information about your personal and business 
contacts.

Creating an Address Book entry
1. Press the address key or tap the Address icon in the 

Applications Launcher.

2. Tap the New button.

3. Enter the information you want to add.

Tab to a line to enter data

 
 
 
 

 
 
 

function-PgDn or function-PgUp to 
move between pages

  

function-details to set display options
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Note: As you enter letters in some fields, matching entries 
in your Address Book appear. For example, if you have 
San Jose and Saratoga in your Address Book and you 
enter “S,” Saratoga appears, then as you enter “a” and 
“n” San Jose replaces Saratoga. To accept the word, tap 
the next field. 

4. After you finish entering information, tap the Done button.

Tip: You can also import a database into Palm Desktop 
software and transfer it to Dana during the next HotSync 
operation. See the Dana User’s Guide and Palm Desktop 
online Help for more information.

Viewing and changing an Address Book 
entry
1. Tap the entry you want to view or change in the Address List 

screen.

2. Tap the Edit button and make your changes.

3. Tap the Details button.

4. Select any of these settings:

• Show in List: Select which information appears in the Address list 
screen: Work, Home, Fax, Other, E-mail, Main, Pager and Mobile

• Category: Assign the entry to a category
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• Private: Hide or mask this entry when Security is turned on. 
You must install the Security application to enable this feature. 
For more information see the Dana User’s Guide.

5. Tap OK.

Deleting an Address Book entry
1. Tap the entry you want to delete.

2. Press the menu key. 

3. Under the Record menu, tap Delete Address. 

Note: If you want to save a copy of the deleted item 
to an archive file in Palm Desktop software, select the 
check box in the confirmation dialog box.

4. Tap OK.

Tip: You can also delete an entry by opening the 
Address Entry Details dialog box, pressing function-
delete..., and then pressing function-ok.

Using Date Book
Date Book lets you quickly and easily schedule appointments or 
any kind of “event” associated with a time and date.

Creating an event
1. Press the date key or tap the Date Book icon in the Applications 

Launcher.
Onboard Applications
     

    
   



2. Tap the Go button and select the date you want for the event.

3. Tap the New button.

4. Enter the Start Time for the event. If the event is longer or shorter 
than an hour, enter an End Time, and then tap OK.

5. Enter a description of the event.

Tip: You can define the default duration for All Day 
events in Date Book preferences.

Creating an untimed event
You can also schedule events in your Date Book that occur on a 
particular date but have no specific start or end times, such as 

Next week Previous week
       Tap a month

   

 

 

 ctrl-cmd-g to select a date

 

 Next year

 

 Previous year
     

   

 Tap a day

 

 Tap a day in the current week

 Tap to set hours

   

 Tap to set minutes

      

Tap for full day duration

    

Time bar shows duration
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birthdays, holidays, and anniversaries. These are referred to as 
“untimed events.” Untimed events appear at the top of the list of 
times, marked with a diamond. You can have more than one 
untimed event on a particular date. 

1. Tap the date that you want for the event.

2. Tap the New button.

3. Tap the No Time button, so that no start or end times are 
defined for the event.

4.  Enter a description of the event.

Tip: If you create an event and decide there is no start 
or end time, you can change it to an untimed event. 
Tap the time of the event in the Date Book screen, 
tap No Time, and then tap OK.

 New untimed event

    

Tap the event time (i.e., 12:00) to change to no time
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Creating a repeating or continuous event
The Repeat function lets you schedule events that recur at regular 
intervals or extend over a period of consecutive days.

A birthday is a good example of an event that repeats annually. 
Another example is a weekly guitar lesson that falls on the same day of 
the week and the same time of day. A business trip or a vacation is an 
example of a continuous event.

1. Tap the event.

2. Tap the Details button.

3. Tap the Repeat box.

4. Tap the repeat interval.

Tip: For a continuous event, select Day.

5. Enter a number on the Every line to indicate the frequency.

For example, if you select Month and enter the number 2, the event 
repeats every other month.

6. (Optional) Tap the End on pick list, tap Choose Date, and select an 
end date. Tap OK.

 Tap Repeat box 

       

 Tap buttons to set repeat intervals
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7. Tap OK. A repeat icon appears to the far right of the event.

Rescheduling an event
1. Tap the event you want to reschedule.

2. Tap the Details button.

3. Tap the Time box and select a new time.

4. Tap the Date box and select a new date.

5. Tap OK.

Changing the calendar view
In addition to displaying the time list for a specific day, you can 
also display a whole week, a month, or an agenda.

•  Tap a view icon to display another view.

 
 

Dot indicates untimed event

 
    

 Bar indicates later event

   

 Week view icon

 

 Tap for that day
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Tip: You can also press the date key repeatedly to display 
the next view.

Deleting an event
1. Tap the event you want to delete.

2. Press the menu key.

3. Under the Record menu, tap Delete Event.

 Previous/next month
 

 Dash on right indicates event

    

 Month view icon

 

 

 Appointments

 

 Agenda view icon
 To do list

 Tap to display a different 
category
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4. If you’re deleting a repeating event, tap the appropriate button:

• Current: Deletes only the current event item.

• Future: Deletes the current and all future event items and resets 
the end date of repeating event to the last shown date.

• All: Deletes all occurrences of the repeating event.

Note: If you want to save a copy of the deleted item 
to an archive file in Palm Desktop software, select the 
check box in the confirmation dialog box.

5. Tap OK.

Tip: You can also delete an event by deleting the text, 
or by opening the Event Details dialog box, pressing 
function-delete..., and then pressing function-ok.

Using To Do List
To Do List is a convenient place to create reminders and prioritize 
the things that you have to do. A record in To Do List is called an 
“item.”
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Creating a To Do List item
1. Press the to do key or tap the To Do List icon in the Applications 

Launcher.

2. Tap the New button.

3. Enter a description. The text can be longer than one line.

4. (Optional) Tap the Priority number on the left side of the item and 
set the Priority number (1 is most important).

Note: When you create a new To Do List item, its 
priority is automatically set to level 1. If you select 
another item first, however, the item you create appears 
beneath the selected item with the same priority as the 
selected item.

Changing a To Do List item
1. Use the up or down arrow key to highlight the entry you want to 

change.

        

 

 function-new

    

function-show to set 
display options

function-details to set 
priority and due date

Enter descriptionTap to select priority
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2. Tap the Details button.

3. Tap the Due Date pick list and select a new date.

• Today: Assigns the current date.

• Tomorrow: Assigns tomorrow’s date.

• One week later: Assigns the date exactly one week from today.

• No Date: Removes the due date from the item.

• Choose Date: Opens the date selector, where you can choose 
any date that you want for the item.

4. Tap OK.

Tip: If you turn on the Show Due Dates option in the 
To Do Show Options dialog box, you can tap 
directly on the due date in the To Do List to open the 
Due Dates pick list.

Tap here
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Marking a To Do List item complete
• Tap the check box on the left side of the item.

Tip: You can set the To Do List Show Options to record 
the date you complete an item, and you can choose to 
show or hide completed items.

Deleting a To Do List item
1. Tap the item you want to delete.

2. Press the menu key.

3. Under the Record menu, tap Delete Item.

Note: If you want to save a copy of the deleted item to an 
archive file in Palm Desktop software, select the check 
box in the confirmation dialog box.

4. Tap OK.

Tip: You can also delete an item by opening the To Do 
Item Details dialog box, pressing function-delete..., and 
then pressing function-ok.

Completed to do item
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Using Memo Pad
Memo Pad provides a place to store information that is not 
associated with Date Book, Address Book, or To Do List. A record 
in Memo Pad is called a “memo.” Each memo can contain up to 
4,000 characters. The number of memos you can store is 
dependent only on Dana’s available memory.

Creating a memo
1. Press the apps key repeatedly till you see ALL in the top right 

corner of the Applications Launcher.

2. Tap on the Memo Pad icon.

3. Tap the New button.

4. Use your keyboard to enter the text you want to appear in the 
memo. Use the enter key to move down to new lines in the 
memo.

5. Tap the Done button.

 function-new
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Reviewing and changing a memo
1. Use the up or down arrow key to highlight the memo you want to 

review or change, then press the enter key.

2. Review or edit the text in the memo.

3. Tap the Done button.

Deleting a memo
1. In the Memo list, tap the memo you want to delete.

2. Press the menu key. 

3. Under the Record menu, tap Delete Memo. 

Note: If you want to save a copy of the deleted memo to 
an archive file in Palm Desktop software, select the check 
box in the confirmation dialog box.

 Tap a memo to review its contents
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4. Tap OK.

Tip: You can also delete a memo by opening the 
Memo Details dialog box, pressing function-delete..., 
and then pressing function-ok.

Printing from Date Book, Address 
Book, To Do List or Memo Pad
You can print records from the Address Book, To Do List, Memo 
Pad, and appointments from the Date Book. Printing files from 
many third-party applications is also supported including: spread-
sheets, presentations, databases, and e-mail. For more information 
on supported applications and printers see the online manual - 
PrintBoyManual.pdf located in the PrintBoy folder under the 
Extras folder on the Palm Desktop for Dana software CD-ROM.

1. If you haven’t already done so, complete the steps for “Printing 
Setup” on page 17.

2. Press the apps key repeatedly till you see ALL in the top right 
corner of the Applications Launcher.

3. Tap the Print icon.

4. Select the type of record you want to print.

5. If you are printing via USB, connect one end of the USB cable to 
the Dana printer port and connect the other end of the cable to 

Tap to select a record 
type
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the printer. If you are printing via infrared (IrDA), point Dana’s 
IrDA port at the Printer’s IrDA port.

6. Select a record and then tap the Print button.

Preferences and other settings
Many of Dana’s settings and preferences can be adjusted to suit your 
needs. You can make changes to the Applications Launcher display, 
date and time settings including their formats, and general preferences 
like auto shutoff interval, alarm options, and sounds. You can also 
customize some of the keyboard settings.

Changing the Applications Launcher 
display
By default, the Applications Launcher displays each application as an 
icon. You can change the settings to show a list of applications.

1. Press the apps key.

2. Press the menu key.

3. Under the Options menu, tap Preferences.

4. Tap the View By pick list and select List. 

Tip: You can return to the same category of applications 
each time you open the Applications Launcher by 
selecting the Remember Last Category check box.

5. Tap OK. 

Setting Date and Time preferences
Use the Date and Time Preferences screen to set the date, time, time 
zone, and Daylight Saving option on Dana.
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1. Press the apps key repeatedly till you see ALL in the top right 
corner of the Applications Launcher.

2. Tap the Prefs icon.

3. Tap the pick list in the upper-right corner and select Date & 
Time.

To set the date:
1. Tap the Set Date box.

2. Tap the arrows to select the current year.

3. Tap a month.

4. Tap the current date.

Tap to set date

     

   

Tap to select date

                 

Tap arrows to select year 
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To set the time:
1. Tap the Set Time box.

2. Tap the up or down arrows in the dialog box to change the hour.

3. Tap each number of the minute, and then tap the arrows to change 
them.

Note: Dana can also display time based on a 24-hour 
clock. See“Changing Formats preferences” on page 49.

4. Tap OK.

To set the time zone:
1. Tap the Set Time Zone box.

2. Tap a time zone.
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Tip: When you travel, changing the current time zone 
setting to a new time zone setting automatically resets 
the date and time on Dana.

3. Tap OK.

To set the daylight saving switch:

• Tap the Daylight Savings pick list, then select On or Off.

Setting General preferences
You can set Dana’s auto shutoff interval, alarm options, and 
sounds. You can also prohibit anyone from beaming information 
to Dana.

1. Press the apps key repeatedly till you see ALL in the top right 
corner of the Applications Launcher.

2. Tap the Prefs icon.

3. Tap the pick list in the upper-right corner and select General.

Note: You can set alarms to notify you of entries 
in your Date Book. See the Dana User's Guide 
for details.

Tap arrow to select 
General

 

 Tap to select delay time

Tap to select sound 
options

Tap to bar incoming beams
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Changing Formats preferences
Use the Formats Preferences screen to set the country default and the 
display format of the dates, times, and numbers on Dana.

1. Press the apps key repeatedly till you see ALL in the top right corner 
of the Applications Launcher.

2. Tap the Prefs icon.

3. Tap the pick list in the upper-right corner and select Formats.

Note: For information on establishing more advanced 
settings (such as for keyboard layout), please check the 
Preferences section of the Dana User's Guide.

Customizing keyboard settings
There are several options you can choose to customize some general 
settings on the Dana keyboard.

Tab key option
You can choose how the tab key operates on Dana using the “Tab 
moves to the next field...” option. When this option is enabled, 

Tap arrow to select Formats 

Tap to set country 

Tap to set time and date formats

 

Tap to set day week starts      

Tap to set number format
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pressing the tab key will move the cursor to the next field, while 
shift-tab will move it to the previous field. When this option is 
disabled, pressing the tab key will insert a tab character.

1. Press the apps key repeatedly till you see ALL in the top right 
corner of the Applications Launcher.

2. Tap the Keyboard icon.

3. Tap the pick list in the upper-right corner and select General.

4. Tap the checkbox for “Tab moves to the next field...”.

Application shortcuts
Here you can choose which applications will launch when you 
press the function key at the same time as one of the File keys (F1-
F8). You can return to the Assign Application Shortcuts screen at 
any time to re-assign keys or to return them to an unassigned state.

1. Press the apps key repeatedly till you see ALL in the top right 
corner of the Applications Launcher.

2. Tap the Keyboard icon.

3. Tap the pick list in the upper-right corner and select App 
Shortcuts.

4. Tap the pick list next to a function+file key combination, then 
tap the application you want to assign.

Rotating the screen
Dana's screen can be rotated using the screen application, so that 
applications can be viewed either horizontally or vertically. 
Viewing the screen vertically can be more convenient for tasks like 
filling out forms or reading an ebook.

1. Press the apps key repeatedly till you see ALL in the top right 
corner of the Applications Launcher.

2. Tap the Screen icon.
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3. Tap an icon to change the screen orientation.

4. Tap the OK button.

Tap an icon to change 
the screen orientation
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CHAPTER 4 Dana In-Depth
Beaming information
You can use the IrDA (infrared) port on Dana to beam the following 
information to another Dana, IrDA-equipped Palm OS organizer, or 
IrDA-equipped printer.

• The file or record currently displayed in AlphaWord (if installed 
on the other device), Date Book, Address Book, To Do List or 
Memo Pad.

• All records of the category currently displayed in Address Book, 
To Do List, or Memo Pad.

• A special Address Book record you designate as your business card 
that contains information to exchange with business contacts.

• An application installed in RAM memory or on an expansion card.

• AlphaWord files to an IrDA-capable printer or IrDA-capable 
computer.

Beaming data
1. Select the item or category to beam.

2. Press the send key.

Note: In AlphaWord the send key is used to send plain 
text to a computer. To beam an AlphaWord file, select 
Beam Doc under the File menu.
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3. When the Beam Status dialog box appears, point the IrDA port 
on the top of Dana at the receiving IrDA port.

Tip: You can also beam data by selecting the 
appropriate beam command from the Record menu.

4. Wait for the Beam Status dialog box to indicate the transfer 
 is done.

Beaming applications
1. Press the apps key.

2. Press the send key.

3. Tap the Beam from pick list, and then select Dana or Card. To 
beam an application from a card, you must have a card inserted 
into the expansion card slot. 

4. Tap the application you want to transfer.

5. Tap Beam. 

6. When the Beam Status dialog box appears, point the IrDA port 
on the top of Dana at the receiving IrDA port. 

7. Wait for the Beam Status dialog box to indicate the transfer is 
done.
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Receiving beamed information
1. Turn on Dana.

2. Point the IrDA port on the top of Dana at the sending IrDA port.

3. When the Beam Status dialog appears, tap Yes.

Beaming your business card
1. Create an Address Book entry with your business card information.

2. Press the menu key.

3. Under the Record menu, tap Select Business Card.

4. Tap the Yes button.

5. Press the address key for about two seconds to beam your business 
card.

Note: Once you complete steps 1 through 4, you do not 
need to repeat this process. Simply press the address key 
for about two seconds to beam your business card.

Beaming tips
• For best results, hold Dana and the other Dana, IrDA-equipped 

handheld or printer between 4 and 39 inches apart, and keep the 
path between the two devices clear of obstacles.

• Some applications are copy-protected and cannot be beamed. These 
are listed with a lock icon next to them.

• You can set the full-screen pen stroke to beam the current entry. See 
the Dana User’s Guide for details.

Installing applications
You can install a variety of additional applications on Dana or on an 
expansion card that is seated in one of the expansion card slots during 
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a HotSync operation. To learn about more add-on applications, go 
to www.alphasmart.com. 

Note: Any application that you install on Dana 
resides in RAM memory; you can delete them at any 
time.

Installing applications using a PC
1. Copy the application you want to install into the Add-on

folder under the Palm folder on your computer. (If the 
application is compressed, expand it into this folder.)

2. Double-click the Palm Desktop icon on your desktop.

3. Click Install, then Click Add.

Tip: You can also launch install by selecting Install 
Tool from the Palm Desktop program group or by 
double-clicking any file with a PRC, PDB, or PNC 
file extension.
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4. When the Open dialog box appears, select the application(s) you 
want to install on Dana or an expansion card and then click Open.

5. If you need to change the destination of the application you are 
installing, click Change Destination on the Install Tool window, and 

Click here to 
select your user 
name

Click add to 
select 
applications to 
install

 

Click here to 
change 
application
destinations
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then use the arrows to move applications between Dana and an 
optional expansion card.

6. Click OK to close the Change Destination window.

7. Click Done to close the Install Tool window.

8. Perform a HotSync operation to install the selected 
application(s).

Installing applications using a Macintosh 
computer
1. Copy or download the application you want to install into the 

Palm folder on your Macintosh.

Note: If the software is compressed, expand it into 
this folder.

2. Double-click the Hotsync Manager icon in the Palm folder.

3. From the HotSync menu, choose Install Handheld Files.

Click to install 
application on 
an expansion 
card
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4. From the User pop-up menu, select your user name.

5. Click Add to List.

6. Select the Palm folder from the pop-up menu.

7. Select the application you want to install.

User pop-up menu

Click Add to 
List to select 
applications 
to install 

Click to move 
applications 
between Dana 
and an expansion 
card

 

Select Palm folder 

Click on 
Add File

   

Select application 
to install
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8. Click Add File to add the selected application to the Install 
Handheld Files list.

9. If you need to change the destination of the application you are 
installing, click Change Destination on the Install Handheld 
Files window, and then use the arrows to move applications 
between Dana and an optional expansion card.

10. Click OK to close the Change Destination window.

11. Close the Install Handheld Files window.

12. Perform a HotSync operation to install the selected 
application(s) on Dana.

Resetting Dana
If Dana does not respond to the keyboard or tapping the screen, 
you need to perform a reset to get Dana running again.

Performing a soft reset
A soft reset tells Dana to stop what it’s doing and start over again 
while retaining all records and entries stored in Dana.
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• Use the stylus (or similar object without a sharp tip) to gently press 
the reset button inside the hole on the back panel of Dana. 

Performing a hard reset
Important: With a hard reset, all files, records and entries 
stored in Dana are erased. Never perform a hard reset 
unless a soft reset does not solve your problem. You can 
restore any data previously synchronized with your 
computer during the next HotSync operation.

1. While holding down the on/off key, use the stylus (or similar object 
without a sharp tip) to gently press and release the reset button

2. Wait for the Palm logo to appear and release the on/off key.

3. A warning will appear that you are about to erase all the data 
stored on Dana. Either press the up arrow key to complete the hard 
reset, or press the memo key to perform a soft reset. 

Installing alkaline batteries
If there is a situation where you are unable to recharge Dana using the 
USB cable or AC adapter, Dana will also operate using 3 AA batteries.
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1. Turn Dana off.

2. Remove optional screw (if installed). 

3. Slide the battery door to the left and lift it off.

4. Remove the rechargeable battery but DO NOT unclip it.

5. Place 3 AA alkaline batteries in the battery compartment 
(positive to right).

Warning: To avoid data loss when changing alkaline 
batteries, always turn Dana off before removing the 
batteries and replace the batteries within 30 seconds.

6. Unclip the rechargeable battery.

7. Replace the battery door and slide it to the right to lock it in 
place.

Battery To Dana

Battery Clip in place

Push to release
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Using expansion cards
Dana has 2 card slots that accepts Secure Digital (SD) or MultiMedia 
Card (MMC) expansion cards. These enable you to add additional 
software applications or hardware. You can also use an expansion card 
to back up data when it is inconvenient to perform a HotSync 
operation.

Inserting an expansion card
1. Hold Dana securely.

2. Insert the card into the expansion card slot, following the direction 
indicated by the expansion card icon on the top of Dana.

3. Use your thumb to push the card into the expansion slot. When you 
feel the card lock and hear the system sound, the card is properly 
seated within the slot.
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Removing an expansion card
1. Hold Dana securely.

2. Use your thumb to lightly push against the top of the card, 
following the direction indicated by the expansion card icon on 
the top of Dana. The expansion card slot releases the card, and 
Dana plays the system sound.

3. Remove the card from the expansion card slot.

Note: Dana comes with dummy cards seated within 
the expansion card slots. To prevent debris from 
entering and damaging the slots, we suggest that you 
leave the dummy cards seated when you are not using 
an expansion card. 

Frequently Asked Questions
If you encounter a problem with your Dana, try the suggestions in 
this section, and the suggestions in the “Frequently Asked 
Questions” chapter in the Dana User’s Guide before contacting 
Technical Support.

If you are still having problems, please contact us using the 
technical support contact information listed on page 83.

Note: There are thousands of third-party applications 
available for Palm OS® devices like Dana. For 
questions and support on these non-AlphaSmart 
applications, please contact the software developer 
directly.

I don’t see anything on my Dana screen
1. Press the on/off key to ensure your Dana is turned on.
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2. Press the function-contrast key. If the Contrast dialog box appears, 
adjust the contrast by holding down the function-up arrow key for 
a few seconds. If this doesn’t work, hold the function-down arrow 
key for a few seconds.

3. Make sure the battery is properly charged.

4. Perform a soft reset. Use the tip of the stylus (or similar object 
without a sharp tip) to gently press the reset button on the back of 
Dana. 

5. If Dana still doesn’t turn on, perform a hard reset by holding down 
the on/off key while doing a soft reset. Wait for the Palm logo to 
appear, then release the on/off key. If you want to continue and 
erase all your data, press the up arrow key. 

Important: With a hard reset, all records and entries 
stored in Dana are erased. Never perform a hard reset 
unless a soft reset does not solve your problem. You can 
restore any data previously synchronized with your 
computer during the next HotSync operation. See the 
Dana User’s Guide for instructions on restoring your 
data.

I can’t complete a HotSync operation
The first step in diagnosing HotSync problems is to determine if Dana 
and the computer are able to communicate with each other.

1. Connect the USB cable to Dana.

2. Confirm that HotSync Manager is running and enabled on the 
computer.

Windows 

On the Windows desktop, double-click the Palm Desktop icon, click 
the HotSync icon on the taskbar and make sure Local USB is checked 
on the menu. If not, click it to insert a check mark.
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Macintosh

Double-click the HotSync Manager icon in the Palm folder. Click 
the HotSync Controls tab and make sure the Enabled option is 
selected.

Hotsync on Macintosh or PC

1. Press the function-sync keys on Dana. 

2. Watch your monitor to see if the HotSync Progress dialog box 
appears (you may also hear the HotSync tones on Dana). 

If the HotSync Progress dialog box does not appear, Dana and 
the computer are not communicating. See “Troubleshooting 
communication problems” later in this chapter.

If the HotSync Progress dialog box appears, Dana and the 
computer are communicating. See “Troubleshooting data 
synchronization problems” later in this chapter.

Click to check 
Local USB
Click to check 
Local USB

Click HotSync 
icon to show
connection 
options
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Troubleshooting communication problems

Check your connections:
1. Check the contact points on Dana and on the USB cable and make 

sure they are clean and free from obstruction.

2. Check the USB cable connection on Dana and on the back of your 
computer to make sure it is properly attached.

3. Perform a HotSync operation. Continue if you’re still having 
problems.

Check Dana settings:
1. Turn on Dana and press the apps key repeatedly till you see ALL in 

the top right corner of the Applications Launcher.

2. Tap the HotSync icon.

3. Make sure Local is highlighted above the HotSync icon and select 
Cable from the pick list below the HotSync icon. 

4. Press function-sync to perform a HotSync operation. Continue if 
you’re still having problems.
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Check your Windows 2000/XP computer settings:
1. Right-click the My Computer icon on your Desktop and select 

Properties.

2. Click the Hardware tab, and then click Device Manager.

3. Click Ports.

4. If the port you are using for the USB cable shows an 
exclamation point, you have a hardware conflict. To resolve 
this, consult the documentation that came with your computer.

Check your Macintosh settings:
1. Make sure you are using Mac OS 9 or newer.

2. Double-click the HotSync Manager in the Palm folder.

3. Click the Connection Settings tab.

4. Make sure USB is selected and that the connection setting 
matches where your USB cable is attached.

Troubleshooting data synchronization 
problems
If your data does not appear on Dana and in the Palm Desktop 
software after a HotSync operation, try the steps in this section.

Note: If you are attempting to synchronize with 
applications other than the Palm Desktop software (e.g., 
Microsoft Outlook, Lotus Notes, etc.) using a third-party 
conduit, please consult the documentation that was 
provided with that application.

Check your desktop configuration:
1. Make sure you selected the user name that matches your Dana.

2. Make sure the date on your computer matches the date on 
your Dana.
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Check the HotSync log:
1. Open the HotSync log.
Windows

Click the HotSync icon on the taskbar and select View Log from the 
menu.

Macintosh

Double-click the HotSync Manager in the Palm folder and choose View 
Log from the HotSync menu.

2. Ensure that all applications are marked OK. If not, continue to the 
next section to check your conduit settings.

Check your conduit settings on a Windows computer:
1. Click the HotSync icon on the taskbar and select Custom.

2. Select the user name that matches the Dana you are attempting to 
synchronize.

3. Ensure that the application conduits (other than Backup and Install) 
are set to Synchronize the Files.

Check your conduit settings on a Macintosh:
1. Double-click the HotSync icon in the Palm folder.

2. From the HotSync Manager menu, choose Conduit Settings.

3. Select the user name that matches the Dana you are attempting to 
synchronize.

4. Ensure that the application conduits (other than Install) are set to 
Synchronize the Files.

Online Help and additional 
information
For more information about using Dana, see the following:
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• This guide, Getting Started with Dana, provides instructions on 
performing basic tasks on your electronic notebook.

• The online handbook, Dana User’s Guide (DanaUsers-
Guide.pdf), provides comprehensive instructions on using Dana 
and the Palm applications that come with it.

• The online help for Palm Desktop software. To access the 
online help, go to the Help menu in Palm Desktop software.

• Additional resources for use with Dana including a file that 
contains Holidays (for the Macintosh) can be found at 
www.alphasmart.com.

Windows

Open the DanaInfo folder inside the Palm folder on your 
computer, and then double-click the DanaUsersGuide.pdf file.

Macintosh

Open the DanaInfo folder inside the Palm folder on your 
computer, and then double-click the DanaUsersGuide.pdf file.

Note: If the DanaUsersGuide file does not open, then 
you need to install Adobe Acrobat from the Palm 
Desktop for Dana Software CD-ROM.

Windows

Open the Acrobat Reader folder and then double-click the 
rp505enu.exe file.

Macintosh

Open the Acrobat Reader folder and then double-click the Acrobat 
Reader Installer.
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APPENDIX A Keyboard Navigation
You can use the keyboard to launch applications, move around in 
applications and menus, and select on-screen buttons and controls. 
See the tables below for the full range of keyboard functions.

Note: Any key commands that use a “two-key” command 
separated by a hyphen (i.e. function-calc) are executed by 
pressing the indicated keys simultaneously.

The table below displays the key combinations used to launch applications 
directly from the keyboard

TABLE 1. Application Shortcut Keys

apps Goes home to the Applications Launcher

date Launches Date Book 

address Launches Address Book

to do Launches To Do List

memo Launches AlphaWord

find Launches Find

send Beams the selected item or category. In AlphaWord, 
sends the current file to a computer (via USB or 
IrDA to AlphaBeam).

function-calc Launches Calculator

function-contrast Launches screen contrast controls

function-sync Performs a HotSync operation

function-F1-F8 Launches application of choice (see “Application 
shortcuts” on page 50 for more details)
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The table below displays the key combinations used to navigate 
between records or fields in open applications. The term “records” 
is used to refer to an individual item in any of the basic 
applications: a single Date Book event, Address Book entry, To Do 
List item, or Memo Pad memo.

TABLE 2. Field/Record Navigation

down arrow In a list of records, moves to next record 

up arrow In a list of records, moves to previous 
record

tab or 

function-shift-down 
arrow

Moves to next field (tab works only 
when enabled - to enable tab see “Tab 
key option” on page 49)

shift-tab or

function-shift-up arrow

Moves to previous field (shift-tab works 
only when enabled)

function-up arrow Moves to previous record/ Page up

function-down arrow Moves to next record/Page down
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The table below displays the key combinations used to select 
on-screen buttons and controls. You can select a button by using its 
shortcut key, or you can press function-tab till the button or control is 
highlighted, and then without releasing the function key press the enter 
key. If after pressing function-enter a list comes up, then without 
releasing the function key use the up or down arrow key to move up or 
down the list

Tip: When manipulating controls that require more 
than one step (for example a list that drops down), the 
function key should not be released until all the steps 
are completed.

TABLE 3. Selecting On-screen Buttons and Controls

function-tab Cycles through available buttons and controls

function-enter Pushes highlighted button or selects highlighted 
control

function-up arrow Moves up a list brought up by function-enter 

function-down 
arrow

Moves down a list brought up by function-enter

function-right 
arrow

Moves slider control right

function-left arrow Moves slider control left

function-new Pushes the new button 

function-cancel or 
esc

Pushes the cancel button 

function-done Pushes the done button 

function-note Pushes the note button 
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The table below displays menu navigation commands.

function-ok Pushes the ok button 

function-show Pushes the show button 

function-details Pushes the details button 

function-Delete… Pushes the Delete… button 

ctrl-cmd-letter Pushes the button where letter specifies a unique 
letter in the button

TABLE 4. Menu Navigation

menu Brings up the menu

right arrow or space bar Moves to next menu

left arrow or backspace Moves to previous menu

down arrow Moves down menu

up arrow Moves up menu

enter Executes highlighted menu item

cmd-tab Brings up the command toolbar

cmd-menu shortcut letter (i.e. 

C for Edit Copy)

Executes appropriate menu item

TABLE 3. Selecting On-screen Buttons and Controls
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APPENDIX B International and 
Special Characters

The Dana keyboard is capable of the full range of special characters and 
typographical options available in the Palm OS. The tables below display 
the keyboard commands that produce these characters.

Note: Any key commands that use a “two-key” 
command separated by a hyphen (i.e. function-^) are 
executed by pressing the indicated keys simultaneously.

TABLE 1. Diacritical Characters

Character Standard Keystroke(s) Notes

á a key followed by Function-" acute accent

é e key followed by Function-" acute accent

í i key followed by Function-" acute accent

ó o key followed by Function-" acute accent

ú u key followed by Function-" acute accent

Á A key followed by Function-" acute accent

É E key followed by Function-" acute accent

Í I key followed by Function-" acute accent

Ó O key followed by Function-" acute accent

Ú U key followed by Function-" acute accent

à a key followed by Function-~ grave accent

è e key followed by Function-~ grave accent

ì i key followed by Function-~ grave accent
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ò o key followed by Function-~ grave accent

ù u key followed by Function-~ grave accent

À A key followed by Function-~ grave accent

È E key followed by Function-~ grave accent

Ì I key followed by Function-~ grave accent

Ò O key followed by Function-~ grave accent

Ù U key followed by Function-~ grave accent

â a key followed by Function-^ circumflex 
accent

ê e key followed by Function-^ circumflex 
accent

î i key followed by Function-^ circumflex 
accent

ô o key followed by Function-^ circumflex 
accent

û u key followed by Function-^ circumflex 
accent

Â A key followed by Function-^ circumflex 
accent

Ê E key followed by Function-^ circumflex 
accent

Î I key followed by Function-^ circumflex 
accent

Ô O key followed by Function-^ circumflex 
accent

TABLE 1. Diacritical Characters
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Û U key followed by Function-^ circumflex 
accent

ä a key followed by Function-: dieresis accent

ë e key followed by Function-: dieresis accent

ï i key followed by Function-: dieresis accent

ö o key followed by Function-: dieresis accent

ü u key followed by Function-: dieresis accent

ÿ y key followed by Function-: dieresis accent

Ä A key followed by Function-: dieresis accent

Ë E key followed by Function-: dieresis accent

Ï I key followed by Function-: dieresis accent

Ö O key followed by Function-: dieresis accent

Ü U key followed by Function-: dieresis accent

Ÿ Y key followed by Function-: dieresis accent

ã  a key followed by Function-Shift-~ tilde accent

ñ n key followed by Function-Shift-~ tilde accent

õ o key followed by Function-Shift-~ tilde accent

Ã A key followed by Function-Shift-~ tilde accent

Ñ N key followed by Function-Shift-~ tilde accent

Õ O key followed by Function-Shift-~ tilde accent

å a key followed by Function-( dot accent

TABLE 1. Diacritical Characters
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Å A key followed by Function-( dot accent

TABLE 2. Special Characters

Character Standard Keystroke(s) Notes

ø Function-o

Ø Function-Shift-o

° Function-d

™ Function-t

® Function-r

© Function-g

ç Function-c

Ç Function-Shift-c

§ Function-s

¶ Function-\

æ Function-a

Æ Function-Shift-a

• Function-w

TABLE 3. Punctuation

Character Standard Keystroke(s) Notes

¿ Function-/

¡ Function-1

TABLE 1. Diacritical Characters
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» Function-. Function key and period key

« Function-, Function key and comma 
key

‘ Function-[

’ Function-]

“ Function-Shift-[

” Function-Shift-]

TABLE 4. Accents

Character Standard Keystroke(s) Notes

` (grave accent) ` 

^ (circumflex) Shift-^

~ (tilde) Shift-~

TABLE 5. Currency

Character Standard Keystroke(s) Notes

€ Function-e

£ Function-p

¢ Function-5

Function-j

¥ Function-y

$ Shift-4

TABLE 3. Punctuation
Getting Started with Dana 79



TABLE 6. Math

Character Standard Key-
stroke(s)

Notes

Function-2

Function-4

Function-3

÷ Function- - Function key and hyphen 
key 

± Function-=

ƒ Function-f

TABLE 7. Greek

Character Standard Keystroke(s) Notes

ß Function-b beta or German Sharp 
S

µ Function-u mu

1/2

1/4

3/4
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APPENDIX C Warranty and 
Guarantee

Warranty
AlphaSmart, Inc. warrants the Dana keyboard and display to be free from 
defects in materials and workmanship from the date of purchase for a 
period of one year in the United States or two years in the European Union.

For rechargeable devices, AlphaSmart, Inc. warrants the rechargeable bat-
tery to be free from defects for 90 days from the date of original purchase.

During this period, if a defect should occur, AlphaSmart, Inc. will, at its 
option, repair or replace Dana at no charge to you, provided that it is 
returned during the warranty period to AlphaSmart, Inc. or one of its 
authorized dealers. This warranty does not apply if Dana has been damaged 
by accident or abuse, or modified without the written permission of 
AlphaSmart, Inc., or if the serial number has been removed or defaced. 

There are no other warranties, expressed or implied. AlphaSmart, Inc. 
accepts no responsibility for consequential damages, including, but not lim-
ited to, loss of profit or benefits.

Guarantee
AlphaSmart, Inc. will refund your money in full (less original shipping 
charges) if the items are returned in original condition within 30 days of 
customer receipt of items.
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APPENDIX D Contact Information 
 and Return Procedures

Sales and Technical Support Contact Information

U.S.:
For technical questions or problems, please contact us by:

• Phone: (888) 274-2720

• Fax: (877) 730-2158

• Email: support@alphasmart.com

• Web: http://www.alphasmart.com/support/index.html

For general information, sales questions, or to purchase AlphaSmart
products, contact us by:

• Phone: (888) 274-0680

• Email: info@alphasmart.com

• Web: www.alphasmart.com 

UK, Europe, Middle East and Africa: 
For technical questions, contact AlphaSmart UK Technical Support by:

• Phone (inside the UK): 0870 120 0718

• Phone (outside the UK): +44 870 120 0718

• Email: UK-help@alphasmart.com

• Web: http://www.alphasmart.eu/support.html 

For general information, sales questions, or to purchase AlphaSmart
products, contact us by:

• Email: europe@alphasmart.info 

• Web: http://www.alphasmart.eu (select your country to access
contact information)
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Asia/Pacific, Canada, Latin America:
For technical support, please contact your local reseller.  Contact
information for AlphaSmart resellers is available on the AlphaSmart 
International Website at

http://www.alphasmart.com/international/apcla.html

If you do not have a local reseller, please contact AlphaSmart Technical 
Support by: 

• Phone: (888) 274-2720

• Fax: 877-730-2158 

• Email: support@alphasmart.com

• Web: http://www.alphasmart.com/support/index.html 

Return Procedures

U.S.:
If you have a problem with your Dana, first read the Frequently Asked 
Questions section in this manual. If this doesn't solve your problems, 
then use the following steps for help.

1. Contact technical support using the contact information listed 
on page 83. Eighty percent of all problems can be solved by 
e-mail or over the phone.

2. If the unit does need to be returned to the factory for repair, it 
must be assigned an RMA (Return Material Authorization) 
number before it is returned in order to track the unit. To 
receive an RMA number, contact technical support using the 
contact information listed on page 83 with the following infor-
mation:

a. a detailed description of the problem.

b. the serial number of the unit.

c. your name and the address where the unit should be returned.
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Only AlphaSmart, Inc. can assign RMA numbers. If a Dana is returned 
without an RMA number, it will delay the repair and increase the chance 
that it could become lost. Please ship the Dana with a reliable shipper. 
AlphaSmart, Inc. will not be held responsible for units that are lost (in ship-
ment from a customer), or that are returned without an RMA number.

3. Write the RMA number on the outside and inside of the box. Also 
on the inside, tape a short, detailed note to the Dana explaining the 
problem (include the RMA number).

4. Ship the damaged Dana to the address given when you receive your 
RMA number. You will be sending the Dana to a repair center, not 
the AlphaSmart, Inc. office.

Your repaired Dana will be returned to you within two weeks of receipt. If 
damages are due to accident or abuse, you will be charged a fee for the parts 
replaced, as well as a repair handling fee.

UK, Europe, Middle East and Africa: 
If you have a problem with your Dana, first read the Frequently Asked 
Questions section in this manual. If this doesn't solve your problems, then 
use the following steps for help.

1. Contact technical support using the contact information listed on 
page 83. Eighty percent of all problems can be solved by 
e-mail or over the phone.

2. If the unit does need to be returned to the factory for repair, it must 
be assigned an RMA (Return Material Authorization) number 
before it is returned in order to track the unit. To receive an RMA 
number, contact technical support using the contact information 
listed on page 83 with the following information:

a. a detailed description of the problem.

b. the serial number of the unit.

c. your name and the address where the unit should be returned.

Only AlphaSmart, Inc. can assign RMA numbers. If a Dana is returned 
without an RMA number, it will delay the repair and increase the chance 
that it could become lost. Please ship the Dana with a reliable shipper. 
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AlphaSmart, Inc. will not be held responsible for units that are lost (in 
shipment from a customer), or that are returned without an RMA num-
ber.

3. Write the RMA number on the outside and inside of the box. 
Also on the inside, tape a short, detailed note to the Dana 
explaining the problem (include the RMA number).

4. Ship the damaged Dana to the address given when you receive 
your RMA number. You will be sending the Dana to a repair 
center, not the AlphaSmart, Inc. office.

Your repaired Dana will be returned to you within two weeks of receipt. 
If damages are due to accident or abuse, you will be charged a fee for the 
parts replaced, as well as a repair handling fee.

Asia/Pacific, Canada, Latin America:
If you have a problem with your Dana, first read the Frequently 
Asked Questions section in this manual. If this doesn't solve your 
problems, then use the following steps for help.

1. Contact technical support using the contact information listed 
on page 83. Eighty percent of the problems can be solved by 
e-mail or over the phone.

2. If the unit needs to be returned to the factory for repair, please 
ship the unit with a reliable shipper using the contact 
information listed on page 84 with the following information:

a. a detailed description of the problem.

b. the serial number of the unit.

c. your name and address where the units should be returned.

AlphaSmart, Inc. will not be responsible for units that are lost (in ship-
ment from a customer).

3. On the inside of the box, tape a short, detailed note to the Dana 
explaining the problem as well as the country you are sending it 
from.

4. Ship the damaged Dana to the address given to you when you 
contacted Technical Support.
86 Contact Information and Return Procedures



A
AC adapter 4
Address Book 30

Changing an Address Book entry 31
Creating an Address Book entry 30
Deleting an Address Book entry 32

Alarm options 48
AlphaWord

Controls 22
Creating an AlphaWord document 14
Deleting a document 25
Editing an AlphaWord document 24
Keyboard commands 23
Transferring a document to 

AlphaWord 21
Transferring a document to your 

computer 19
Application shortcuts 50
Applications Launcher 29

Changing Applications Launcher 
display 45

Auto shutoff interval 48

B
Backlight 6
Batteries

Installing alkaline batteries 61
Rechargeable battery 4

Beaming 53
Beaming applications 54
Beaming data 53
Beaming tips 55
Beaming your business card 55
Receiving beamed information 55

C
Charging Dana 4
Connecting Dana to a computer 11
Contrast 7

D
Date Book 32

Calendar view 36

Creating a repeating or continuous 
event 35

Creating an event 32
Creating an untimed event 33
Deleting an event 37
Rescheduling an event 36

Daylight saving switch 48

E
Expansion cards 63

F
F1-F8 13
First time set up 4
Fonts 25
Frequently Asked Questions 64

H
Hard reset 61
HotSync 11

I
Infrared 1
Infrared printing 18
Installing applications 55
Installing desktop software 8
IrDA printing 18

J
Justification 22

K
Keyboard navigation

Field/Record navigation 72
Menu navigation 73
Selecting on-screen buttons and 

controls 73
Keyboard settings 49

L
Launching applications 29
Getting Started with Dana



M
Memo Pad 42

Creating a memo 42
Deleting a memo 43
Reviewing and changing a memo 43

MultiMedia Card 63

P
Palm Applications 3
Palm Desktop software 9
Paragraph formatting 22
Password 27
Preferences 45

Changing Formats preferences 49
Setting Date and Time preferences 45
Setting General preferences 48

Printing 18

R
Resetting Dana 60
Rotating the screen 50

S
Secure Digital Card 63
Soft reset 60
Spell Check 15
Synchronizing data with HotSync 11

T
Tab key option 49
Text transfer to a computer 20
Thesaurus 16
Time zone 47
To Do List 38

Changing a To Do List item 39
Creating a To Do List item 39
Deleting a To Do List item 41
Marking a To Do List item complete 41

U
Upgrading from a Palm OS handheld 7
USB cable 11

W
WritePad 5
Index


	Contents
	CHAPTER 1 A Dana Tour
	Utilizing Dana’s wide screen
	Preparing to use Dana
	Charging Dana
	Dana first time set up

	WritePad basics
	Using the screen’s backlight
	Adjusting the LCD contrast
	Upgrading from a Palm OS handheld
	Installing desktop software
	Connecting Dana to a computer
	Synchronizing data using HotSync

	CHAPTER 2 AlphaWord
	AlphaWord Basics
	Creating an AlphaWord document
	Using Spell Check
	Using Thesaurus
	Printing

	Connecting to your Computer
	Send versus HotSync
	HotSync a new AlphaWord document to your computer
	Sending text to your computer
	HotSync a desktop document to AlphaWord

	AlphaWord In-depth
	AlphaWord controls
	Deleting a document
	Installing additional fonts on Dana
	Setting a file password


	CHAPTER 3 Onboard Applications
	Launching Applications
	Using Address Book
	Creating an Address Book entry
	Viewing and changing an Address Book entry
	Deleting an Address Book entry

	Using Date Book
	Creating an event
	Creating an untimed event
	Creating a repeating or continuous event
	Rescheduling an event
	Changing the calendar view
	Deleting an event

	Using To Do List
	Creating a To Do List item
	Changing a To Do List item
	Marking a To Do List item complete
	Deleting a To Do List item

	Using Memo Pad
	Creating a memo
	Reviewing and changing a memo
	Deleting a memo

	Printing from Date Book, Address Book, To Do List or Memo Pad
	Preferences and other settings
	Changing the Applications Launcher display
	Setting Date and Time preferences
	Setting General preferences
	Changing Formats preferences

	Customizing keyboard settings

	CHAPTER 4 Dana In-Depth
	Beaming information
	Beaming data
	Beaming applications
	Receiving beamed information
	Beaming your business card

	Installing applications
	Resetting Dana
	Performing a soft reset
	Performing a hard reset

	Installing alkaline batteries
	Using expansion cards
	Inserting an expansion card
	Removing an expansion card

	Frequently Asked Questions
	Online Help and additional information

	APPENDIX A Keyboard Navigation
	APPENDIX B International and Special Characters
	APPENDIX C Warranty and Guarantee
	APPENDIX D Contact Information and Return Procedures
	Index

